
Copyright © 2022, ACS Technologies. All Rights Reserved. 

 

 
 

 

 

 

 ACS Reports and Report Designer 
 

 

 

 

 

  



 2 

Reports ......................................................................................................................................................................... 3 

The Reports Window .................................................................................................................................................... 3 

Setting up Printers in ACS Financial Suite Reports ...................................................................................................... 12 

Setting up Printers in ACS Reports ............................................................................................................................. 13 

Report Designer.......................................................................................................................................................... 15 

Report Designer Workspaces ..................................................................................................................................... 17 

Editing Data Export Options ....................................................................................................................................... 22 

Report Bands .............................................................................................................................................................. 27 

Customizing the Reports Window .............................................................................................................................. 50 

  



 3 

Reports 
ACS People Suite and ACS Financial Suite offer many reports to fit your church, school, or organization's 

needs. The reports are included with your software, and you can customize them in a variety of ways. 

When you select a report in either product, you can view a sample report with demo data as well as a 

report description, which can help you determine if a report will fit your needs before you print it. 

Some tasks apply to all reports, such as e-mailing and exporting reports. If this is what you're looking for, 

you're in the right place- select a topic below to learn more about working with reports in general. 

If you can't customize a report to suit your needs, check out Report Designer to create a new report from 

scratch. 

The Reports Window 
In the ACS reports window, you can select pre-configured reports for each area of ACS People and 

Financial suites. You can customize, preview, save these reports, and much more. 

Here's a visual overview of the Reports window. 

 

1. Open and log in to ACS People Suite. 
2. Under Searches and Reports, click the Reports tab. 

3. Select the area you want to generate a report for and click Go . 

 

1. Open and log in to ACS Financial Suite. 
2. Under Generate Reports, click the Reports tab. 

3. Select the area you want to generate a report for and click Go . 

 
Customizing Reports 
ACS reports are highly customizable, but not all customization options are available for all reports. 

1. In the Reports window, select the report you want to customize 
2. If customizing a Contributions or Financial Suite report, select the appropriate date range in the lower 

sidebar. 
3. Click Customize. 

https://wiki.acstechnologies.com/display/ACSDOC/People+Suite
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
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4. Select the options you want to display on your report. To learn about these customization options, 

see the ACS User Guide and select the area you are working in. 
5. To display your report, click Preview. 

 

Displaying Names Formally and Informally in Reports 
In ACS Reports, you can choose to display names formally, informally, or using a custom name format. 

This is helpful when you are adapting reports to different situations. 

For example, Contributions statements often use formal names to ensure that they match government 

records when tax season comes around. The formal, informal, and custom names are stored with 

individual's records in ACS People. You can also choose whether or not to include middle names, "goes 

by" names, titles, and suffixes, or print last names before first names. 

1. In the reports window, select the report you want to customize. 
2. Optional: If customizing a Contributions or Financial Suite report, select the appropriate date range 

in the lower sidebar. 
3. Click Customize. 
4. Under Name Options, select either Formal Label Name, Informal Label Name, or Custom Label 

Name. 
5. Select or clear the other options according to your preference. 
6. To view the report, click Preview. 

 

Filtering Reports 
Filtering reports lets you narrow down what data is included in the report. Think of filtering as a quick 

version of searching. For example, if you want to send a letter to all women in your organization, you can 

add a filter to show only women in the Master Listing of Addresses report. 

 

1. In the reports window, select the report you want to filter. 
2. Optional: If the report is a Contributions or Financial Suite report, select the appropriate date range 

in the lower sidebar. 
3. Click Customize. 
4. On the Report Options tab, select Filter, then click Select. 
5. In the Edit Report Filter window, under Available Fields, expand the field categories until you locate 

a field you want to apply to the filter. 
6. Select the field and click Add. 
7. Enter the criteria for the field and click OK. For example, "gender = female." 
8. When you finish adding criteria to the filter, click Close. 
9. To view the filtered report, click Preview.  

Note 

Filtering is not available for all reports. If this is the case, the option is grayed-out. 

https://wiki.acstechnologies.com/display/ACSDOC/ACS+Help
https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
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Flagging People in Reports 
In many ACS reports, you can select member statuses in the report results. 

For example, you might need to prepare a Master Listing of People report with non-resident members 

flagged so you can send them a special insert for your organization's homecoming celebration. In this 

situation, the Flag People option comes in handy, and people with the member status you selected are 

flagged with an asterisk. 

Flagging people is not available for all reports. If this is the case, the option is grayed-out. 

1. In the reports window, select the report you want to customize. 
2. Optional: If the report is a Contributions or Financial Suite report, select the appropriate date range 

in the lower sidebar. 
3. Click Customize. 
4. Under Report Options, select Flag People and click Select. 

5. In the Member Statuses column, select the member status you want to flag and click Add.  Your 
selection displays in the Selected Member Statuses column. You can select up to five statuses, 

depending on the report. 
6. To accept your selections and return to the customize window, click Close. 
7. To view the report, click Preview. 
 

 

Grouping People in Reports 
Similar to sorting, you can group individuals by up to four different fields in report results. Additionally, you 

can choose to require a page-break after each group. 

For example, suppose your church assigns elders to each family and you use a custom field in ACS to 

track elder assignments. On occasion, you probably need to print a list of families and elder assignments 

so that the elders know who they're responsible for. (A helpful report for this is the Names and Special 

Fields report.) In this case, you can group the families by their assigned elder. To make it easier to hand 

out the printed pages, you can require a page-break after each elder's list of assignments. 

 

1. In the reports window, select the report. 
2. If the report is a Contributions or Financial Suite report, select the report's date range in the lower 

sidebar. 
3. Click Customize. 
4. Under Formatting, select Group and click Select. 

5. In the Fields column, select the field and click Add.  
6. When you are finished selecting the fields to group by, click Close. 
7. To require a page-break after each group, select Page Break on Last Group. 
8. To view the report, click Preview. 

 

Note 

Grouping people is not available for all reports. 

https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
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Hiding Area Codes in Reports 
In many ACS reports, you can hide phone number area codes in the report results. For example, say you 

need to print a Master Listing of People to keep on file for reference. Since most of your organization's 

members have the same area code, you decide to hide the area code in the report results. All phone 

numbers with that area code display without the area code. Other phone numbers with area codes still 

display their area codes. 

1. In the reports window, select the report. 
2. If the report is a Contributions or Financial Suite report, select the report's date range in the lower 

sidebar. 
3. Click Customize. 
4. Under Formatting, select Suppress Area Code and click Select. The Suppress Area Code window 

displays. 
5. Enter the area code you want to hide. 

6. Click Add . The area code displays in the Suppressed Area Codes column. You can enter up 

to five area codes, depending on the report. 
7. When you are finished entering area codes, click Close. 
8. To view the report, click Preview. 

 

 

Hiding City, State, and ZIP Codes in Reports 
In many ACS reports, you can hide the city, state, and ZIP code in the report results. For example, say 

you need to print a Master Listing of People to keep on file for reference. Since most of your 

organization's members live in the same city, you decide to hide the city, state, and ZIP code in the report 

results. The city, state, and ZIP code still displays for anyone who doesn't live within the specified ZIP 

code. 

1. In the Reports window, select the report. 
2. If the report is a Contributions or Financial Suite report, select the report's date range in the lower 

sidebar. 
3. Click Customize. 
4. On the Report Options tab, under Formatting, select Suppress City State Zip and click Select. 
5. Enter the ZIP Code for the city and state you want to hide. 

6. Click Add.  The ZIP code displays in the Suppressed ZIP Codes column. You can enter up to 

five ZIP Codes, depending on the report. When you finish, click Close. 
7. To view the report, click Preview. 

 

 

Including Comments in Reports 
You can print comments on a report, depending on the selected report. For example, let's say you have a 

comment field named Home Directions. You can print this comment field on a report and give it to your 

visitation team. 

1. In the Reports window, select the report. 

https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
https://wiki.acstechnologies.com/display/ACSDOC/Contributions
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2. If the report is a Contributions or Financial Suite report, select the appropriate date range in the lower 

sidebar. 
3. Click Customize. 
4. Under Formatting, select Print Comments and click Select. 

5. Under Comment Types, select the comment type you want and click Add.  
6. To save your selections, click Close. 
7. To view the report, click Preview. 

 

 

Including Special Fields in Reports 
Including special fields in your reports lets you print information that is not included by default. For 

example, your youth pastor may want a list of all high school students who attend your church. 

Additionally, besides typical name and address information, she wants the following included: their 

school’s name, the subdivision they live in, the date they last attended church, and their parents' names. 

The availability of special fields depends on what you track in ACS and, in some instances, the security 

level of the user setting up the report. Fields such as age, date of birth, and social security number are 

not available if security for the user is set to None for these options. You can select up to ten special 

fields. 

 

1. In the Reports window, select the report you want to customize. 
2. If the report is a Contributions or Financial Suite report, select the report's date range in the lower 

sidebar. 
3. Click Customize. 
4. Under Report Options, select Special Fields and click Select. The Special Fields window 

displays. 
5. In the Column drop-down list, select the special field that you want to include. 
6. If you want to change how the field displays in the report, enter a new name under Description. 

7. To move the field to the Selected Special Fields column, click Add.  
8. To change the sort order of the fields in the Selected Special Fields column, select a field and 

click  

the Up  or Down . 
9. To accept your selections and return to the customize window, click Close. 
10. To view the report, click Preview. 

Newsletter Flags 
When selecting Newsletter Flag as a special field, a code will print on the report under the Newsletter 

Flag column. This code is based on a combination of the Newsletter flag and the Deliver by flag. 

Note 

Special fields are not available for all reports. 

https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
https://wiki.acstechnologies.com/display/ACSDOC/Contributions
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Selecting a Date Range for Reports 
In many ACS reports, you can select a date range to apply to the report results. Selecting a date range 

limits the report results based on the records that fall within the date range. For example, if you select the 

date range January 1, 2011 — June 1, 2011 for the People Changes Log, and the report displays only 

the changes made between those dates. 

1. In the reports window, select the report you want to customize. 
2. In the lower sidebar, click Customize. 
3. Under Date Range, select Use Date Range. 
4. In the first date field, select the start date. 
5. In the second date field, select the end date. 
6. To view the report, click Preview. 
 

 

Sorting within Reports 
In many ACS reports, you can sort the order in which individuals or organizations display in the report. 

When you custom sort a report, you specify the ACS field on which to sort, such as age, city, date joined, 

marital status, or record type. You can select up to four fields to sort by, depending upon the report. 

For example, suppose your organization is planning social events for single and married members of 

different age groups. You need to print a listing of all members, sorted by marital status and date of 

birth.  When customizing the report, you’d select Custom Sort and sort by the Marital Status and Date 

of Birth fields. When you preview the report, your members are grouped by marital status and date of 

birth. 

 

1. In the reports window, select the report. 

Report Code Newsletter Flag Deliver by Flag 

N None None 

2 Individual Both 

I Individual Mail 

1 Individual E-mail 

B Family Both 

F Family Mail 

E Family E-mail 

Note 

Custom sorting is not available for all reports. If this is the case, the option is grayed-out. 
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2. If you're working with a Contributions or Financial Suite report, select the report's date range in the 

lower sidebar. 
3. Click Customize. 
4. Under Report Options, select Custom Sort and click Select. The Selection window displays. 
5. In the Fields column, select the field you want to sort by. 

6. To move the field to the Selected Fields column, click Add.  

click the Up   or Down . 7. To change the sort order of the fields, select a field and 

8. To accept your selections and return to the customize window, click Close. 
9. To view the report, click Preview. When the report displays, it is sorted by the selected fields. 

 

 

Managing Report Page Setup 
After customizing and previewing a report, you can manage its page setup. You can control the paper 

size, margins, and orientation of the report. This is helpful for printing reports that require specific paper, 

such as contributions statements. 

1. In the Reports window, select the report. 
2. If you're working with a Contributions or Financial Suite report, select the report's date range in the 

lower sidebar. 
3. Click Customize. 
4. Select the appropriate report options, then click Preview. 

5. On the reports toolbar, click Page Setup.  
6. Under Paper Size, manage the width and height of the paper. 
7. On the Margins tab, manage the margins and page orientation. 
8. Click OK. 

 

 

Searching for Text in Reports 
Sometimes when you generate a report, you want to look at a specific area of data. For example, when 

you generate an attendance report, you may want to see how many absences a specific person had. 

Rather than scour the report for that person, you can simply search for his or her name. 

You can search for matching whole words only, for matching capitalization, and starting from the first or 

last page of the report. 

1. In the Reports window, select the report. 
2. If you're working with a Contributions or Financial Suite report, select the report's date range in the 

lower sidebar. 
3. Click Customize. 
4. Select the appropriate report options, then click Preview. 

5. On the reports toolbar, click Search.  
6. Enter the text you are looking for. For example, Jane Smith 
7. Press Enter. 

https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
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8. The first occurrence of the text is highlighted and displays in the report preview. To see the next 

occurrence of the text, click Next.  
 

 

Previewing Reports 
Many pre-configured reports are available for you in ACS, and sample reports display when you select a 

report. However, you can preview reports with your own ACS data, which gives you a better idea of how 

the report might be useful to your church or organization and also lets you see how many pages the 

report is. 

After previewing the report, you may want to search within the report, customize, print, e-mail, or export it. 

1. In the reports window, select the report. 
2. In the lower sidebar, click Preview. The report displays with your organization's data. 

 

 

Setting Report Fonts 
You can customize the fonts that display on a report. When customizing fonts, keep in mind that reports 

are designed for certain font sizes; using other fonts or changing the font size may result in formatting 

issues. For example, when printing labels, a different font style/size may cause the text to run off the 

label. Always check for formatting issues by previewing the report after you change the font. 

Changes to a report's font are not permanent unless you save the report. Changing a font only affects the 

current report; it doesn't affect any other reports. 

1. In the reports window, select the report you want to generate. 
2. If the report is a Contributions or Financial Suite report, select the report's date range in the lower 

sidebar. 
3. Click Customize. 
4. On the Report Options tab, select the appropriate customization options, then click Preview. 

5. On the reports toolbar, click Set Font.  
6. Select the style, color, and font size, then click OK. 
 

 

Copying Reports as Images 
Some reports, especially graphs, are particularly useful as images. You can copy the report as an image 

and paste it into an e-mail, document, or presentation. Keep in mind that when you copy a report as an 

image, you can only copy the page you are currently viewing; you cannot copy more than one page at 

time. 

1. In the Reports window, select the report you want to copy. 
2. If the report is a Contributions or Financial Suite report, select the report's date range in the lower 

sidebar. 
3. Click Customize. 
4. On the Report Options tab, select the appropriate options for your report, then click Preview. 

https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
https://wiki.acstechnologies.com/display/ACSDOC/Contributions
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5. On the reports toolbar, click Copy.  
6. Navigate to the location where you want to paste the report image. 
7. Right-click and select Paste. 

 

 

Refreshing Reports 
You can refresh a report to show the most current data entered into your ACS records. This is helpful if 

you have multiple people working in ACS at the same time or if you have to step away from your work for 

an extended period. 

Refreshing a report is only necessary if the previewed report is already displaying on your screen. If you 

have to navigate to the report, you are already generating the most current data when you preview it. 

1. In the Reports window, select, customize, and preview your report. 

2. On the reports toolbar, click Refresh. . The updated report displays. 
 

 

Renaming Reports 
After you have customized and previewed a report, you can rename and save it. You can also rename a 

report that you have already saved. 

Renaming a report can be useful for indicating how you customized it. It is also helpful for making the 

report recognizable to other users. For example, you can apply a filter to the Master Listing of People 

report to include only members between the ages of 12 and 17. When you save the report, you might 

rename it Youth Members 12 - 17. 

1. In the reports window, select the saved report. 
2. In the lower sidebar, select Preview. The report displays. 

3. On the reports toolbar, click Save . 
4. In the Save As field, enter the new report name. If you want the title at the top of the report to match, 

enter the new name in the Report Title field as well. 
5. Click Save. 

 

 

Saving Reports 
If you find that you often customize a report in the same way, you should save the report. Saving the 

report allows to you customize the report settings once and generate the report when you need it. 

You can also rename and delete saved reports if you need to. 

1. In the Reports window, select the report you want to save. 
2. Click Customize. 
3. On the Report Options tab, select the appropriate options for your report. When finished, click 

Preview. 

4. On the toolbar, click Save . 
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5. Enter the Save As file name. (This name appears in the reports sidebar.) 6.  Enter the Report Title. 

(The title displays at the top of the report itself.) 
7. Enter a Description. 
8. To make the customized report available to other users, select Public. 
9. Click Save. 

1. In the reports window, select the report you want to delete. 
2. In the lower sidebar, click Delete. 
3. When the confirmation message displays, click Yes. 

Printing Reports 
After you have customized and previewed a report, you may want to print it. You may want to print a 

report to share it with other people, to bring it to a meeting, or to have a hard copy for filing purposes. 

You can also print a range of pages.   

You can also print the report without customizing it, which prints with the default options.  

1. In the reports window, select the report you want to print. 
2. Optional: If printing a Contributions or Financial Suite report, select the appropriate date range in the 

lower sidebar. 
3. To customize your report, click Customize. 
4. On the Report Options tab, make the appropriate selections and click Preview. 

5. When the report displays, click Print Report . 
6. In the Name drop-down list, select the printer you want to print to. 
7. To print only a range of pages, enter the first and last page numbers for the Page Range. For 

example, 7-20. 
8. Under Copies, enter the number of copies you want to print. 
9. Select any other options and click OK. 

 

1. In the reports window, select the report you want to print. 
2. Optional: If printing a Contributions or Financial Suite report, select the appropriate date range in the 

lower sidebar. 
3. In the lower sidebar, click Print. An options window displays. 
4. In the Name drop-down list, select the printer you want to print to. 
5. To print only a range of pages, enter the first and last page numbers for the Page Range. For 

example, 7-20. 
6. Under Copies, enter the number of copies you want to print. 
7. Select any other options and click OK. 

 

Setting up Printers in ACS Financial Suite Reports 
When printing reports in ACS Financial Suite, you can select the printer you want to use or update the 

printer settings, allowing you to further customize report printing. 

1. Under Generate Reports, click Printer Setup. 
2. In the Reports Setup window, select the Printer to use when printing reports. 

https://wiki.acstechnologies.com/display/ACSDOC/Contributions
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3. Under Print Settings, clear the settings you want to change. You can change the default margins, 

orientation, paper settings, or font. 
4. Click Setup. 
5. In the Page Setup window, select the appropriate options on the Paper, Margins, and Header 

/Footer tabs.  
Paper — Select the paper size, width, height, and paper source to use when printing reports. 
Margins — Select the left, right, top, and bottom margins for your report. The default margin is .25. 

Keep in mind that if you change the margins, words or numbers may not print correctly on your report. 

You can also change the print orientation (portrait or landscape). 
Header/Footer — Under sections, select the default header, footer, and title section for your report. To 

create custom headers, footers, and title sections, click Edit. To retain the default font you selected in 

Reports Setup, select Always Retain Font. To print a separate title page for the report, under Default 

Title Section, select Print as Separate Page. 
6. When finished, click OK. 
7. In the Reports Setup window, click OK to save your changes. 
 

Setting up Printers in ACS Reports 
When printing reports in ACS People or Financial Suite, you can select the printer you want to use or 

update the printer settings, allowing you to further customize report printing. It's also a good idea to 

download updated printer drivers when needed. 

  

1. Under Generate Reports, click Printer Setup. 
2. In the Reports Setup window, select the Printer to use when printing reports. 
3. Under Print Settings, clear the settings you want to change. You can change the default margins, 

orientation, paper settings, or font. 
4. Click Setup. 
5. In the Page Setup window, select the appropriate options on the Paper, Margins, and Header 

/Footer tabs.  
Paper — Select the paper size, width, height, and paper source to use when printing reports. 
Margins — Select the left, right, top, and bottom margins for your report. The default margin is .25. 

Keep in mind that if you change the margins, words or numbers may not print correctly on your report. 

You can also change the print orientation (portrait or landscape). 
Header/Footer — Under sections, select the default header, footer, and title section for your report. To 

create custom headers, footers, and title sections, click Edit. To retain the default font you selected in 

Reports Setup, select Always Retain Font. To print a separate title page for the report, under Default 

Title Section, select Print as Separate Page. 
6. When finished, click OK. 
7. In the Reports Setup window, click OK to save your changes. 

 

E-mailing and Exporting Reports 
You can e-mail and export reports in various formats such as PDF files and Excel® spreadsheets. All 

reports can be exported using the Print to File option from the Print menu. Some reports also have a 

Data View option that you can export from in formats such as Excel and Microsoft Access®. 
 

1. In the reports window, select the report you want to e-mail. 
2. Optional: If the report is a Contributions or Financial Suite report, select the appropriate date range 

in the lower sidebar. 

https://wiki.acstechnologies.com/display/ACSDOC/Contributions
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3. Click Customize. 
4. Select the appropriate report options, then click Preview. 

5. On the reports toolbar, click E-mail Report . 
6. Select the file format you want to email the file as. 
7. An options window displays. The available options differ depending on your selection. 
8. Select your settings, then click OK. Your default e-mail client opens with the report attached. 

Exporting to Excel 

When exporting to Excel through the Print to File option, the headings display on every page. When 

exporting to Excel from the View Data window, the headings display at the top of the first page. 

1. In the reports window, select the report you want to export. 
2. Optional: If the report is a Contributions or Financial Suite report, select the appropriate date range 

in the lower sidebar. 
3. Click Customize. 
4. Select the appropriate report options, then click Preview. 

5. On the reports toolbar, click Print Report . 
6. In the options window, select Print to File, then select the file type in the drop-down list. 

7. To select the location where the file is saved, click Browse . 
8. Navigate to the location and click Save. 
9. Depending on the file type, another options window may display. Select your options and click OK. 
10. Click OK. 

 

 

1. In the reports window, select the report you want to export. 
2. Optional: If the report is a Contributions or Financial Suite report, select the appropriate date range 

in the lower sidebar. 
3. Click Customize. 
4. Select the appropriate report options, then click Preview. 

5. On the reports toolbar, click View Report Data . 
6. Click the arrow beside Export, then select the file type.  
7. Select the location to save the file and enter the File Name. Click Save.  

Note 

This option is only available on some reports. 

https://wiki.acstechnologies.com/display/ACSDOC/Contributions
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Report Designer 
Can't customize a report to suit your needs? Are you a technology enthusiast? If you answered "yes" to 

both of these questions, Report Designer may be right for you. 

Report Designer lets you create customized reports from scratch. Report Designer provides powerful 

query and design functionality to help you create in-depth, professional reports. It also provides a way to 

organize your reports and leads you through the initial report-building steps. 

If you are new to Report Designer, check out the overview and the learning tutorial. You can also select 

or search for a topic below. 

Technical Expertise Required 

Report Designer has awesome powers of customization, but the trade-off is a learning curve. 

Working with Report Designer requires a fair amount of technical knowledge.  

If you find that Report Designer isn't the right tool for you, we also offer professional report 

customization for a fee. If you are interested, please contact Support. 

 

Overview of Report Designer 
With ACS Report Designer, you can 

• Save the Reports You Design — Reports you create are associated with specific modules in Report 

Designer. Once you save a report, you can retrieve it, edit it, and save it with a new title. 

• Use ACS Advanced Exports to Specify the Data Source — The Data Source options lets you 

create a new export to use with the report you are designing. Or, you can use an existing ACS 

Advanced Export as the data source. When you work with the report, you can edit the export and 

refresh the export's data. 

• Sort Data — You can sort the data returned in the report based on the fields you select in Report 

Options. 

• Import and Export — Report Designer includes import and export functionality so that you can share 

reports between organizations and send and receive reports from ACS Support. 

• Use the Query Wizard and Quick Design Tools — Report Designer has a Query Wizard and Report 
Wizard to help you with data retrieval and report design. The Query Wizard walks you through 

selecting tables, fields, calculations, groupings, rows, and sort order. The query selections determine 

what data displays in your report. 

•  Complete Learning Tutorials to Learn Report Designer — Before you begin creating reports, set 

aside a day to complete the tutorial guide provided with the software. Completing the guide familiarizes 

you with many of the tools and concepts found in the Report Designer and is an excellent reference 

when building your own reports.  

https://wiki.acstechnologies.com/display/ACSDOC/Report+Designer+Learning+Resources#ReportDesignerLearningResources-tutorial
http://www.acstechnologies.com/clientportal
https://wiki.acstechnologies.com/display/ACSDOC/Report+Designer+Learning+Resources#ReportDesignerLearningResources-tutorial


 16 

Report Designer Learning Resources 
The Design Workspace of ACS Report Designer is provided by Digital Metaphor's software, Report 

Builder.  
For detailed instruction on using Report Builder, see the Digital Metaphors help below. Please note that 

ACS uses Report Builder Enterprise version 10.09. These help links may be for different versions of 

Report Builder. 

If you think you would benefit from personalized training with Report Designer, check out our training 

services, which are available at an additional cost. 

Report Designer Tutorial Guide 
Use the Report Designer tutorial guide to familiarize yourself with basic report building tasks and 

advanced report-building techniques. The guide is a series of tutorials that use a sample database to 

teach you how to create reports from start to finish. The tutorials begin with the basics, such as adjusting 

bands, and ends with advanced reporting techniques, like crosstab creation. 

Set Aside a Day 

Before you begin designing reports, set aside a day to complete the tutorials. Keep in mind that 

they build on one another, moving from basic concepts to complex reports. Therefore, it may be 

difficult to complete an advanced tutorial without having first completed earlier lessons. Each 

tutorial produces some kind of report using important aspects of Report Designer. 

To use the Report Designer tutorial guide, download and install the setup file first. 

1. Download the setup file. 
2. Once it is downloaded, open the file. 
3. Follow the instructions in the setup window. 

When you finish installing the tutorial guide, you can being using it. 

1. In the ACS Report Designer Tutorial folder, open the Learn Report Designer Guide. 
2. Start reading. When it prompts you to try a task, open the Learn Report Designer file. This is a 

standalone version of Report Designer that includes sample data. Use it to complete the tutorial 

lessons. 
3. If you need further instruction, open the Learn Report Designer Help file. 

  

https://portal.acstechnologies.com/acs/training/
https://portal.acstechnologies.com/acs/training/
https://portal.acstechnologies.com/acs/training/
https://wiki.acstechnologies.com/download/attachments/21806076/ReportDesigner_Tutorial_Setup.EXE?version=1&modificationDate=1322497737712&api=v2
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Additional Information 
This tutorial guide is for an earlier version of Report Designer. Please keep in mind that the steps for 

accomplishing tasks, as described in the guide, may differ from the current version of ACS Report 

Designer. For help with design in the current version, see Designing Reports. 

 

Report Designer Calculations Help 
 

Report Application Pascal (RAP) is the programming language used for formula calculations in the 

Report Designer. The RAP user guide provides useful information on the functionality found on the 

designer's Calc workspace and on the Calculations menu option associated with the Variable report 

component. 

Technical Expertise Required 

This section contains programmer-level help. Although some of the information is not relevant for 

typical Report Designer users, the reference material is helpful when using the calculation features 

of Report Designer. 

1. Download the RAP user guide. 
2. Once the file is downloaded, open it. 

Report Designer Workspaces 
Report Designer contains four distinct workspaces with different tools for creating professional reports: 

• The Design Workspace 

• The Preview Workspace 

• The Data Workspace 

• The Calc Workspace 

The Design Workspace 
 

When you select Design Reports, Report Designer defaults to the Design workspace. This is where you 

spend the majority of your report-building time. The Design workspace is divided into two areas: the 

workbench and the canvas. The workbench is comprised of toolbars, component palettes, rulers, and 

other tools that you can use to manipulate the canvas. The canvas is the area that contains the report 

layout. This is where you place bands and components that ultimately control the content of each page of 

the report. 

The canvas is made up of the header, detail, and footer bands. The header band displays at the top of 

each page of the report, the detail band makes up the body of the report, and the footer band displays at 

the bottom of each page of the report. 

https://wiki.acstechnologies.com/download/attachments/20866583/RAP%20Help.hlp?version=1&modificationDate=1320937761343&api=v2
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The Preview Workspace 
 

The Preview tab plays an integral role in creating reports. It displays the report on the screen in its 

printed format. As your report develops, you can access the Preview workspace to see how it is shaping 

up. You can make changes and corrections based on the report's appearance. Using the tools in this 

workspace, you can view each page of the report or zoom in to get a better look at a specific page. You 

can also print the report in the Preview workspace. 

The Data Workspace 
 

Use the Data workspace to select and manipulate data for a given report. In most cases, you will not 

need to use the Data workspace because the Report Designer interfaces with ACS Advanced Export to 

select data for your report. You can use an existing Advanced Export or create a new one, depending on 

your reporting needs. This method of data selection simplifies the query process and makes it easier to 

select data without an in-depth knowledge of databases. Using ACS Advanced Export to select data 

eliminates the need to use the query functionality of the Data workspace when you are designing a 

report. 

The Calc Workspace 
 

Report Application Pascal (RAP) is the programming language used for formula calculations in the 

Report Designer. The RAP user guide provides useful information on the functionality found on the 

designer's Calc workspace and on the Calculations menu option associated with the Variable report 

component.  

 

Creating Reports with Report Designer 
You can open Report Designer in the ACS Reports window or in the ACS program menu. 

1. Under Searches and Reports, click the Reports tab. 
2. In the drop-down list, select Report Designer. 

3. Click Go . 

To open Report Designer in the ACS program menu, click Start > All Programs > ACS Technologies > 

R eport Designer. 

After you have opened Report Designer, you can create a new report or modify a standard report. 

https://wiki.acstechnologies.com/display/ACSDOC/Advanced+Exports
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Creating and Modifying Reports 
 

Report Designer provides several pre-designed standard reports based on frequently used ACS reports. 

To quickly report your latest data, you can use these reports as they are. You can also modify a standard 

report and save it under a different name. 

For a complete list of standard reports, see Available Report Designer Types. If the standard reports don't 

meet your needs, you can create a new report from scratch. 

Whether you create a new report or modify an existing one, the process includes three overall steps: 

1. Selecting a data source 
2. Setting the data sort order 
3. Designing the report 

After you have customized a report, you can save it. If you've created and saved several new reports, you 

may want to organize them. You can also import a designed report or modify a report template that you 

saved previously. 

  

Modifying a Standard Report 
You can modify a standard report in Report Designer to better fit your organization's needs and save it 

under a different report name. Study the standard report thoroughly and determine what changes you 

need to make before accessing the report to make changes. This will save you time during the editing 

process and reduce the chance of error. 

1. Under Searches and Reports, click the Reports tab. 

2. In the drop-down list, select Report Designer and click Go . 
3. In the upper sidebar, select Contributions, Connections, People, or Organizations. 
4. In the Reports list, select the standard report. 
5. In the lower sidebar, click Customize. 
6. Modify the data source, sort order, and report design. 

After you have modified the report, you can save it. 

 

Creating a Data Source 
The first step in creating a new report is selecting the data that it pulls. You can choose from several 

methods for retrieving report data: 

• Create a Data Export — Interfaces with ACS Advanced Export in Searches. You can use the 

Data Export Designer to create a new data export for your report. 

• Import an ACS Advanced Export — Imports an existing ACS Advanced Export. 

• Create an Org Staff/Activities Extract — Pulls staff, activities, and other organization data from the 

Organizations module. 

• Create a People Direct Datasource — Pulls People data from a specific dataset. 

https://wiki.acstechnologies.com/display/ACSDOC/Saving+Designed+Reports#SavingDesignedReports-osr
https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Connections
https://wiki.acstechnologies.com/display/ACSDOC/Connections
https://wiki.acstechnologies.com/display/ACSDOC/People
https://wiki.acstechnologies.com/display/ACSDOC/Organizations
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• Create a Financial Direct Datasource — Pulls Financial data from a specific dataset. 

After you have selected the data source, you should set the data sort order. 

Creating a Data Export 
 

Uses the Advanced Export functionality in Searches to create a data export for your report. 

1. On the Report Options tab, click Get Report Data. 
2. Select Create a Data Export. 
3. In the Select Export Type window, select one of the following: 

File Export — This option enables you to create a single file containing selected export information. If 

you are unsure of which export type to choose, select this option. 
Database Export — This option enables you to create multiple files that are linked by common fields. 

4. Click OK. The ACS Data Export Designer displays. 
5. Optional: Click Description to enter a description of the export. 
6. On the Groups and Fields tabs, manage the options to your liking. 
7. Click Save & Close. The export is generated automatically. 
8. A message displays indicating that you can limit the number of records exported. Do one of the 

following: 

 To limit the number of records exported, enter the maximum number of records to export and then click 

OK. To export all records, click OK. 

Importing an ACS Advanced Export 
 

You can import an existing Advanced Export to retrieve data for your report. 

1. On the Report Options tab, click Get Report Data. 
2. Select Import an ACS Advanced Export. 
3. Select the advanced export file. 
4. Click OK. 
5. A message displays indicating that you can limit the number of records exported. Do one of the 

following: 
• To limit the number of records exported, enter the maximum number of records to export and then 

click OK.  

• To export all records, click OK. 

 

 

Creating an Org Staff/Activities Extract 
 

https://wiki.acstechnologies.com/display/ACSDOC/Advanced+Exports
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You can extract Organizations data into Report Designer. You must have the Organizations module to 

use this option. 

1. On the Report Options tab, click Get Report Data. 
2. Select Create an Org Staff/Activities Extract. 
3. Under Date Selection, select the Effective Date. 
4. To include only active staff in the extract, select Include Active Staff Only. (Otherwise, both active 

and inactive staff are included.) 
5. Under Staff Phone/E-mail Settings, select the data you want to export for: 

Business Type 
Mobile Type 
Pager Type 
Fax Type 

E-mail Type 
6. Under Include Activity Groups, select Include All to include all Activity Groups. Or, select only the 

Activity Groups you want to include. 
7. Click Save. 

Creating a People Direct Datasource 
 

If you have more than one ACS Financial Suite dataset, you can select a specific dataset as your report 

data source. If have only one dataset, it is selected as the People Direct Datasource by default. 

1. On the Report Options tab, click Get Report Data. 
2. Select Create a People Direct Datasource. 
3. To include archived datasets in your list of options, select Include Archived Datasets. 
4. Select the dataset. 
5. Click OK. 

Creating a Financial Direct Datasource 
 

If you have more than one ACS People Suite dataset, you can select a specific dataset as your report 

data source. If have only one dataset, it is selected as the Financial Direct Datasource by default. 

1. On the Report Options tab, click Get Report Data. 
2. Select Create a Financial Direct Datasource. 
3. To include archived datasets in your list of options, select Include Archived Datasets. 
4. Select the dataset. 
5. Click OK. 

 

https://wiki.acstechnologies.com/display/ACSDOC/Organizations
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
https://wiki.acstechnologies.com/display/ACSDOC/People+Suite


 22 

Editing Data Export Options 
Once a report is associated with a data source, you can edit the data export. For example, you may want 

to modify the data export of a standard or saved report. 

Create Data Source First 

The editing data options are only available when the report is already associated with a data 

source. The specific edit options available depend on the chosen data source. If the edit options 

are not available, you must create a data source first. 

1. On the Report Options tab, click Get Report Data. 
2. Select the edit option associated with the chosen data source. 
3. When the Data Export Designer displays, make the changes to the export and click Save & Close. 
4. A message displays indicating that you can limit the number of records exported. Do one of the 

following: 

• To limit the number of records exported, enter the maximum number of records to export and click 

OK to refresh the data. 

• To export all records, click OK. 
 

Refreshing a Data Source 
Once a report is associated with a data source, you can refresh the data for the report. This ensures that 

your reports contain the most recent data retrieved in the export. 

Using the refresh option, you can also limit the number of records exported so you can work with a 

smaller subset of the data while designing your report. This decreases the time it takes to process data 

before you design the report. After you have finished the report design, you can then export all records. 

You can refresh data at any time. When you create a data export, import a data export, or edit data 

export options, the program prompts you to refresh data. You may also be prompted to refresh data 

when you set the data sort order or click Design Report. 
 

1. On the Report Options tab, click Refresh Data. 
2. A message displays indicating that you can limit the number of records exported. Do one of the 

following: 
To limit the number of records exported, enter the maximum number of records to export and click OK 

to refresh the data. 
To export all records, click OK. 

 

Setting the Data Sort Order 
Once you have created the data source for your report, you can set the sort order of the data. Setting the 

sort order is especially important for reports that include vast amounts of data. It makes locating 

information within the report much easier. 

When you set the data sort order, you select what fields to sort the report by. The first field in the list is 

the primary sort criteria: the data is sorted by this field first. You can choose additional fields to sort by, up 

to a max of 15. 
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For example, you generate a report of all the people in your dataset. Your first sort field is Member 

Status.  
This is helpful because it sorts everyone into the status of member, visitor, contributor only, and so on.  
However, whether you have 80 or 8,000 members, you need further organization within these categories. 

So, you select Last Name as the second sort field. This way, the report is sorted first by member status, 

but the names within each status are also sorted by last name. 

1. On the Report Options tab, click Set Data Sort Order. 
2. In the Available Fields list, double-click the first field. It then displays in the Sort Report by list. 
3. If you prefer, select another field to sort by. You can select a max of 15 fields. 
4. To re-arrange the order of fields, click Move Up and Move Down. 
5. To remove a field from the Sort by list, select it and click Remove. 
6. You can specify whether the data is sorted in Ascending (A...Z, 1...10) or Descending (Z...A, 10... 

1) order. 
7. When you are finished, click OK. 

Once you have set the data sort order, you can design the report. 

  

Designing Reports 
Once you have selected data for your report and set the sort order, you can design your report. You do 

this by creating a layout of objects that describe how the document will look. 

1. On the Report Options tab, click Design Report. 
2. A message displays indicating the last time the data was exported and gives an option to limit the 

number of records exported. Do one of the following: 
To limit the number of records exported, enter the maximum number of records to export and click Yes 

to refresh the data. 
To export all records and refresh the data, click Yes. 
If you do not want to refresh the data, click No. 

The Design Workspace opens. 

 

Customizing the Page Setup in Report Designer 
In Report Designer, you can customize the page setup to change your paper size and margins, print in 

portrait or landscape orientation, and choose the number of columns for your reports. These options are 

for both viewing and printing reports. 

1. On the Report Designer menu, select the report. 
2. Click Customize and select your Data Source and Report Options. 
3. Click Design Report > OK. 
4. Click File > Page Setup. 
5. Select the Paper tab. 
6. Select the Printer Name. 
7. Select the Paper Size, and enter or select the Width and Height. 
8. Select the Paper Source. 
9. Click OK. 



 24 

1. On the Report Designer menu, select the report. 
2. Click Customize and select your Data Source and Report Options. 
3. Click Design Report > OK. 
4. Click File > Page Setup. 
5. Select the Margins tab. 
6. Under Margins, enter the values you want for each margin, or click the arrows to select these values. 
7. Under Orientation, select Portrait or Landscape. 
8. Click OK. 

1. On the Report Designer menu, select the report. 
2. Click Customize and select your Data Source and Report Options. 
3. Click Design Report > OK. 
4. Click File > Page Setup. 
5. Select the Columns tab. 
6. Enter the number of columns that you want, or click the arrows to increase or decrease the number 

of columns. 
7. On the Columns tab, select additional options.  
8. Click OK. 

 

Combining Two Fields on a Report 
For some reports, you may want to combine two ACS fields into one. For example, you may want to print 

names in First Name + Last Name format (for example, Jane Aaron). You can do this in Report Designer  

by using a Variable component . To do this, first create a sample report with your ACS data. Then, 

you can combine the first and last name fields. 

1. Under Searches and Reports, click the Reports tab. 

2. In the drop-down list, select Report Designer and click Go . 
3. In the Report Type list, select the People report type, then select Create a New Report. 
4. In the lower sidebar, click Customize. 
5. Click Get Report Data > Create a Data Export. 
6. In the Select Export Type window, select Database Export and then click OK. The ACS Data 

Export Designer window displays. 
7. On the Groups tab, select People. 
8. Click the Included Data tab and then select Personal. 
9. Click Save & Close. 
10. In the Refresh Export window, enter the number of records you want to limit the export to and then 

click OK. 
11. On the Report Options tab, click Design Report. 
12. In the New Items window, click Cancel. 

1. In the design workspace, click Variable . 
2. Click in the Detail band to place a Variable component in the report. 
3. Right-click the Variable component and then select Calculations... . 
4. In the Code Toolbox: Data section of the Calculations window, select People. 
5. On the Data tab, click the FirstName field and drag it to the left area of the Calculations window.  
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The following text displays: 
Value := People['FirstName'] 

6. Type a plus sign, an apostrophe, a blank space, an apostrophe, and a plus sign. The calculation 

should now look like this: 
Value := People['FirstName']+' '+ 

7. On the Data tab, click the LastName field and drag it to the left area of the Calculations window.  
The calculation should now look like this: 
Value := People['FirstName']+' '+ People['LastName'] 

8. Type a semicolon. The final calculation should look like this: Value := People['FirstName']+' '+ 
People['LastName']; 9.  Right-click in the left area of the Calculations window. 

10. Select Compile. At the bottom of the window, a message displays indicating any errors in 

calculation. 
11. To return to the design workspace, click OK. 
12. To check your calculation, click the Preview tab. The names on the report should look like this: 

 
 

Creating a Cover Page for a Report 
When you create a report for formal presentation, you may want to add a cover page to introduce your 

report. 

1. In the design workspace, on the Report menu, select Title. 
2. Increase the height of the title band by dragging the divider down until the guide reaches the 9.5 inch 

mark on the vertical ruler. 
3. Place the components you need to design your cover page in the Title band. 
4. Design the cover page. 
 

Creating a Tabular Report 
When you create a tabular report in Report Designer, labels display across the page and data displays 

down the page. 

1. In the design workspace, on the Report menu, select Data Tree. 
2. On the Data Tree, click the Layout tab. 
3. In the Style list, select Tabular.  
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Creating a Vertical Report 
When you create a vertical report in Report Designer, labels display down the page and data displays 

across the page. 

1. In the design workspace, on the Report menu, select Data Tree. 
2. On the Data Tree, click the Layout tab. 
3. In the Style list, select Vertical. 
 

 

Creating Labels in Report Designer 
You can use the Label Templates wizard in Report Designer to create labels and other items such as 

name tags. 

1. In the design workspace, on the File menu, select New. 
2. In the New Items window, select Label Templates. 
3. Click OK. 
4. In the Label Templates window, select the appropriate printer and label information. 
5. Click OK. 
6. Add the desired information to the label in the design workspace. 
 

Entering Additional Field Descriptions in Report Designer 
Your additional lists, fields, and dates are used to print the Individual Request for Information – Blank and 

Individual Request for Information with Data reports. Because the lists, fields, and dates are unique for 

each organization, the labels on the reports are not automatically inserted. You must edit the labels on 

these reports for the appropriate information to display. 

Once you have a list of your additional data, you can enter the descriptions in the report labels. 

1. Under Manage Records, click the People tab. 

2. In the drop-down list, select View/Edit Individual and click Go . 
3. Select a record and then click View/Edit. 
4. Click the Additional Fields tab. 
5. Click the Family tab. 
6. Print this screen or write down the field names. 

Note 

Make sure you copy the field names in the exact order that they appear, including any fields labeled No t 

Defined. The fields appear in the same order on the Individual Request for Information reports, so you 

need to keep them in the appropriate order to know which field is which. 

7.  Click Close. 

1. Open Report Designer, 
2. Select the specific Individual Request for Information report. 
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3. In the lower sidebar, click Customize. 
4. On the Report Options tab, click Design Report. 
5. The additional fields, lists, and dates are labeled Open Category, Open Field, or Open Date. Click 

the first label to select it. 
6. Enter the label for the additional field in the Set Value box located on the toolbar. 

 

7. Repeat step 4 for each additional field, list, and date on the report. 

 
Inserting an Image in Report Designer 
When designing a report, you can insert images. You can insert images from your computer, such as 

your church's logo, and you can also insert family and individual photos from the ACS database. 

1. In the design workspace, on the Standard Components toolbar, click Image . 
2. Place the Image component in the appropriate position in the Detail band. 
3. Right-click the Image component and select Picture... . 
4. Select the image file you want to include from the appropriate directory. 
5. Click Open. 

1. On the Design tab, click RDDBImage . 
2. Place the field in the location that you want in the Detail band. 
3. From the Data Field drop-down list, select the picture type that you want to include. 
4. Right-click the picture field, then select MaintainAspectRatio. 
5. Right-click the picture field then select Stretch. 

 

Report Bands 
When you create a Report Designer report, you do a significant amount of work in the canvas. The 

canvas is divided into sections called bands. A band is labeled in the section divider immediately below it; 

thus, the first band is called the Header, the second is called the Detail, and the third is called the Footer. 

When the report generates, the bands are printed on different parts of the page. 

The bands available for use when creating a report are: 

• Header — Components placed in the header band print at the top of each page of the report. 

• Detail — Components placed in the detail band make up the body of the report. 

• Footer — Components placed in the footer band print at the bottom of each page of the report. 

• Title — Components placed in the title band print at the beginning of the report, displayed as a title. 

Summary — Components placed in the summary band print at the end of the report, such as a total 

record count or total amount. 

• Page Style — A page style can be designed just like a report band, but it generates as a background 

to the bands of the report. Page Styles are used to produce forms. 

• Group Header — Components placed in a group header band print at the beginning of a group of 
information. 

Useful Information 

If any of your additional fields, lists, or dates are  , you can make the label and blank next  Not Defined 
to it visible by right-clicking the component and clearing the   option. Visible 
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• Group Footer — Components placed in the group footer band print at the end of a group of 

information. 

Adjusting Report Bands 
The bands of your report can be adjusted to accommodate the size of larger components, or additional 

components, as necessary. For example, if you want to increase the height of the header band to 

accommodate a large logo or table title, you can do so using the ruler on the left side of the Design 

workspace. 

1. Place your cursor on the divider label for the band to adjust. For example, if you want to adjust the 

Header band, place the cursor over the Header divider label. The cursor changes to an up/down 

arrow, indicating that you can drag the divider up and down. 
2. Hold down the left mouse button and drag the divider up and down to adjust the size. 

 

 
Report Components 
A report component is an element used to control how a report looks. Each component has a unique 

purpose. There are four types of components used in Report Designer: 

• Standard Components 

• Data Components 

• Advanced Components 

• Check Box Components 

Standard Components 
The Standard Components in Report Designer are the components that are most frequently used to 

build reports. The standard report components include items such as labels, memo, and images. These 

components do not retrieve data from your database to display. Rather, you assign the content that a 

standard component displays when you are creating the report. 

Data Components 
The data components in Report Designer are similar to the standard components. The difference is that 

data components are data-aware, meaning that they have the ability to read the value of a field from a 

database table and then display that value in the report. You associate a data-aware component with a 

database table and field by selecting the data pipeline and the data field from drop-down lists in the edit 

toolbar. 

Useful Information 

Notice the two lines that display on the vertical ruler to the left of the divider. These lines are  
called "guides" because they represent the new position of the divider. 
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Advanced Components 
The advanced components help you with complex reporting requirements. You can create regions, 

subreports, and crosstabs using advanced components. See Advanced Component Selection. 

Check Box Components 
CheckBox components in Report Designer are components that can be used to place marked or 

unmarked check boxes in a customized report. CheckBox components help you to avoid having to 

manually draw your check boxes, and can be used in a variety of ways. You can use CheckBox 

components to display a constant marked or unmarked value in your report. You can also configure 

CheckBox components to retrieve data and display as marked or unmarked in your report based upon 

the selected Boolean value. The two types of CheckBox components available in Report Designer are 

CheckBox and DBCheckBox. 

CheckBox 

You can use the CheckBox component to display either a constant checked value or an empty check box 

on your report. For example, if you wanted to create a basic group list for an activity or event to 

determine which individuals would be willing to participate, you could place an unchecked CheckBox 

beside each of the individual records on your report and then mark each of the participating individuals as 

they sign up. Once you have placed a CheckBox component on your report, you can use the Edit toolbar 

to select the type of checkbox that you want and right-click the CheckBox component to access the 

Checked speed menu option. 

DBCheckBox 

You can use the DBCheckBox component to read the value of a field from a database and display a 

checked or unchecked box based upon the values you select on the Checkbox Settings window. Once 

you have placed a DBCheckBox component on your report, you can use the Edit toolbar to set the data 

pipeline and select a data field for the check box. 
 

Advanced Component Selection 
When you are using a shape component as a background for a band, you need to use specific 

techniques to select multiple components while using a bounding box in front of that background shape. 

The bounding box method described in the Basic Component Selection topic does not apply when you 

use a component as a background. 

1. Hold down the Ctrl key. 
2. Click on the white space to the left of the first component. 
3. Hold down the left mouse button. 
4. Drag the mouse until the box encloses all the components. 

When you release the mouse, all of the components are selected. Notice that the background 

component is also selected. 

1. Hold down the Shift key. 
2. Click the component. Click in the white space of another band. Or, click a deselected component.  
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Aligning Components 
When you are designing a report, there are components that must be aligned with each other. For 

example, if you are using three labels in your Header, you may want to align them by the top or bottom of 

the component boxes. You may also want to left-align each label component with its corresponding 

DBText component. 

To align components 

1. Select one of the components to align and adjust its position appropriately. 
2. Press and hold the Shift key. 
3. Select the other components. 
4. Release the Shift key. Notice that all of the components stay selected. 
5. Click the appropriate alignment icon for the type of alignment you want to perform. For example, if you 

are aligning your label components at the top of each label component box, click Align Top . 

All selected components are aligned with the first component. 

Basic Component Selection 
Once the components of your report are created, you need to carefully position them to create a 

highquality report. To position components, you need to understand component selection in Report 

Designer.  
Here are some tips for selecting components in Report Designer. 

Select a component by clicking it. The selected component should look like this: 

To select additional components, hold down the Shift key and then click the other components. All of the 

additional components, and the original component, should now be selected. You can tell that they are 

selected by the small gray boxes surrounding each component. These boxes are called selection 

handles. 

 
You can select multiple components using a bounding box. To select components using a bounding 

box, click in the white space to the left of the first component, hold down the left mouse button, and drag 

the mouse until the box encloses all the components. When you release the mouse, all the components 

are selected. If you place your cursor over one of the components and drag it in any direction, all the 
selected components move in unison. This is called a component selection. 

 
Click in the white space of any design band to deselect components. 
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Bolding Text in Components 
1.  Select the component(s) you want to display in bold type. Small gray boxes, called selection handles, 

display around each component to indicate that it is selected. 

 
 

Configuring a DBCheckBox Component 
You can configure a DBCheckBox component to retrieve data and display as marked or unmarked in 

your report based upon the selected Boolean value. 

To configure a DBCheckBox Component 

1. On the Data Component workspace toolbar, click DBCheckBox . 
2. Click the white space of the Detail band to place a DBCheckBox component in the detail band. 
3. Notice that there are two drop-down lists in the upper left corner of the Design workspace. The 

dropdown list on the left, the Data Field list, contains the fields selected from the data sets.  The drop-

down list on the right, the Data Pipeline Name list, contains the data sets from which you selected 

data in the Advanced Export. 
4. In the Data Field list, select the data field for the DBCheckBox component. The first field value 

displays in the DBCheckBox component. 
5. In the Data Pipeline Name list, select the data set of the field you want to select for the DBCheckBox 

component. 
6. Right-click the DBCheckBox component to access the Speed Menu. 
7. Click Settings. The Check Box Settings window displays. 
8. Select a Style for the check box. 
9. Enter the Boolean True and Boolean False values that you want. 
10. Click OK. 

  

Creating a DBText Component 
A DBText component displays data from a database field you selected in the Advanced Export used for 

the report. DBText components cannot handle rich text or images. 

To create a DBText component 

1. On the Design workspace toolbar, click DBText . 
2. Click the white space of the Detail band to place a DBText component in the detail band. 

Notice that there are two drop-down lists in the upper left corner of the Design workspace. The 

dropdown list on the left, the Data Field list, contains the fields selected from the data sets. The drop-

down list on the right, the Data Pipeline Name list, contains the data sets from which you selected data 
in the Advanced Export. 

2 .   Click    . All selected components display in bold type. Bold 

Tip 

To bold multiple components at once, press and hold the   key while selecting the components. Shift 
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3. In the Data Field list, select the field for the DBText component. The first field value displays in the DB 

Text component. 
4. In the Data Pipeline Name list, select the data set of the field you want to select for the DBText 

component. 
 

 
 

Front-to-Back Order 
In Report Designer, you can use a shape component to create a background for other components. To 

do this, you need to establish the correct front-to-back order for components. Front-to-back order refers 

to the order components are presented in when they overlap. When you are creating a background for a 

report band, you need to position it behind the other components in the band, or "send it to the back." To 

access the available options for ordering a component, simply right-click the component. 
 

Placing and Naming Label Components 
A label is a component in the Standard Component Palette that functions as a header for another kind of 

component, such as a DBText component. Labels are placed in the header band of the Design 

workspace so they print on each page of the report. Proper label naming is important in making your 

report columns easy to follow. 

To place and name a label in the Design workspace 

1. On the Standard Components toolbar, click Label . 
2. Click the white space of the header band to create a label. 
3. Locate the Edit toolbar (below the label component icon on the toolbar). It should contain the text 

'Label1', which is the caption of the currently selected label. 
4. Select the text in the edit toolbar and enter the label name. 
5. Repeat steps 1 through 4 to create additional labels for your report. 

 

Positioning Components 
Once you have added a component in the design workspace, you can adjust the position of the 

component box to better format your report. 

To adjust the position of a component 

1. Right-click the component and select Position... 
2. Set the appropriate Left position, Top position, Width, and Height of the component. 
3. Click Apply. 
4. Click OK. 

Tip 

To see the names of these lists, place the cursor over the field. A tool tip displays the name of the  
list. 
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Tip 

Use the vertical and horizontal rulers to position components. If the rulers are not visible, in the 

View menu, select Rulers. When a component is selected, you can view the measurements of the 

component in the lower right side of the status bar. 

 

Sizing Components 
To achieve the best format for reports, you need to resize components. You can make components larger 

or smaller, depending on the area you want to use in the report band and what is displayed in the 

component. 

To size a component 

1. Make sure all components are deselected: click in the white space of any report band. 
2. Select the component. 
3. When the component is selected, small black boxes (called sizing handles) display around the box 

outline. Place the cursor over the appropriate sizing handle. The cursor becomes a double-arrow. Hold 

down the left mouse button and drag the cursor to a new size. 

Tip 

Use the guides on the vertical and horizontal rulers to determine the position and size of the 

component. You can also adjust the size of a component by selecting it, holding down the Shift key, 

and pressing the arrow keys. (Use this method to size multiple component selections. 

Sizing a Component Stretched to ParentHeight and ParentWidth 
When you have a shape stretched using ParentWidth and ParentHeight, you cannot change the size 

using the sizing handles. 

To size a component stretched to ParentHeight and ParentWidth 

1. Select the component. 
2. Right-click the component and select ParentHeight. The ParentHeight option is cleared. 
3. Right-click the component and select ParentWidth. The ParentWidth option is cleared. 
4. Use the sizing handles to modify the size of the shape.  
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Stretchable Components 
The DBMemo is a special class of component called a "stretchable." As the report prints, stretchable 

components increase or decrease in height based on their content. This differs from static components, 

which always print with the same height. When a band contains both static and stretchable components, 

it is difficult to get the printed pages of a report to look exactly right because stretchable components print 

at a height that is different from the one given in the report layout. The following properties can help you 

keep your reports looking good when you use stretchables. 

 

Using a Shape as a Background 
If you want to add color to your report, you can use a shape as a background for a report band. 

Useful Information 

While working through this procedure, any components you have in the report band you are 

working in will be hidden behind the shape component. They are not deleted; when you complete 

the procedure, the components will move in front of the background component. 

To use a shape as a background 

1. On the Design workspace toolbar, click Shape . 
2. Click in the report band you want to give a background. 
3. Right-click the Shape component you created and select ParentHeight. The height of the component 

stretches to the height of the band. 
4. Right-click the component and select ParentWidth. The width of the component stretches to the width 

of the band. 

5. On the Draw toolbar, click the Fill Color arrow . 
6. Select the color to use as the background for the band. 
7. Right-click the component and select Send to Back. 
 

Report Designer Groups 
A group is a section of a report that contains a group header, detail, and group footer band. It includes 

records that have a common value for a field that you have selected to group your data by. For example, 

if you select Member Status to group your data by, the reported data displays in groups under each 

member status. 

When working with groups, you should understand these three important concepts: 

• Data Traversal and Groups 

• Groups and Sorting Data 

• Creating Groups 
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Data Traversal and Groups 
 

Data Traversal 

A report is generated based on a database table. A database table is a collection of data organized into 

columns and rows. A report document (the pages you see in the print preview window) is created when 

the report generates a detail band for each row in the database table. The act of moving from one row in 

the table to the next is called data traversal. Data traversal can have a dramatic effect on how the report 

document is generated, especially in the case of groups. 

Groups 

Report groups are represented in the layout by a matched pair of bands: the group header and group 

footer. The group header prints when the group begins; the group footer prints when the group has 

ended. For example, let's say you want to see the orders received by a business, organized by each 

month of the year. You would first create a data selection sorted by month, then you'd create a group 

based on the 'month' field.  

Groups and Sorting Data 
 

Groups 

When you create groups, you assign them to a field. As the report generates, the group tracks the value 

of the assigned field. If the field value changes when the report moves from one row of the database 

table to the next, then the current group ends (the group footer prints) and the next group begins (the 

group header prints). Group headers always print at the beginning of a report - in order to start the first 

group - and group footers always print at the end of the report - in order to finish the last group. 

Sorting Data 

Groups let you organize the report into sets of rows that share a common value. However, groups can 

only function if the field they're assigned to has been used to sort the data. If you associate a group with 

a field, but do not sort the data by that field, the group will function. That is, the group will generate a 

group footer and group header each time the field value changes, but because the data is not sorted 

properly, the group appears to generate at random. Whenever you see a group generating too many 

times, make sure the data is sorted properly. 

Creating Groups 
 

When designing a report, you can create groups that group data based on the value of a specified field. 

For groups to work properly, you must set the sort order for your data by the field you want to group by. 



 36 

Make sure that your data source includes the field you want to group by, and that you sort the data by the 

field you want to group by. 

1. On the Design Workspace Report menu, select Groups. 
2. In the Groups list, select the field you want to use to group data. Note:Make sure you select a field 

that you are using to sort your data. 
3. Click Add. 
4. In the Break On section, select Data Field. 
5. To start a new page each time the group value changes, in the On Group Change section, select St 

art new page. 
6. To have the page numbering start over for each group, select Reset page number. 
7. To reprint the header information for each group, select Reprint group headers on subsequent 

pages. 
8. Click OK. 
9. Add the appropriate components to your group header and footer. 

 
Report Designer Regions 
A region is a special type of component that can contain other components. You can associate a set of 

informational components with a single stretching component (such as a memo) in a band using a region. 

By placing components in a region that is associated with a stretching component, you can ensure that 

components keep their appropriate placements and that stretchable components do not hide them. 

The region component moves relative to the stretching component. You place other components in a 

region by dragging them into it. When you resize or move a region, the components inside the region 

shift to accommodate the changes in the region. 

When layouts contain multiple stretching components, and other related components are not printing in 

the correct positions, you can often fix this by using regions to logically group components, then 

assigning the S hiftRelativeTo property to associate regions with the appropriate stretching component. 

When designing a report, you can use a region to associate a set of informational components with a 

single stretching component in a band. 

1. On the Advanced Component toolbar, click Region . 
2. In the Detail band, click in the area where you want to insert a region. 
3. Use the sizing handles to size the region appropriately. 
4. Select the components you want in the region; drag and drop them into the region area. 
 

Report Designer Speed Menus 
The speed menu displays when you right-click a component. It offers different options for altering the 

overall look of your component via changes in shape, size, and visibility. The speed menu varies slightly 

for different components. 

 

 

Useful Information 

When you open a speed menu, it applies only to the component you right-clicked, regardless of any  
components you have selected. 
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Report Designer Toolbars 
Report Designer has several toolbars, component palettes, and data trees to help you design a report: 

• Nudge Toolbar 

• Size Toolbar 

• Draw Toolbar 

• Align or Space Toolbar 

• Standard Component Palette 

• Data Component Palette 

• Advanced Component Palette 

• Report Tree 

• Data Tree 

• Standard Toolbar 

• Format Toolbar 

• Edit Toolbar 

To view a list of all toolbars in Report Designer, on the View menu, select Toolbars. Or, right-click over 

the gray area of the workbench. 

Nudge Toolbar 
Use this toolbar when you want to move a component or selection of components with extreme 

precision. Each icon represents the direction the selection will move. Selections move one pixel each 

time you press an arrow key. 

 

  

Button Function 

  Nudge Up 
Moves all selected components up one pixel. 

  Nudge Down 
Moves all selected components down one pixel. 

  Nudge Left 
Moves all selected components one pixel to the left. 

  Nudge Right 
Moves all selected components one pixel to the right. 
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Size Toolbar 
Use the Size toolbar to set all of the components within a selection to a uniform height or width. 

 
Determines the minimum width of all selected components, then sets  

 Shrink Width the width of the components to that value. 

to Smallest 

Determines the maximum width of all selected components, then sets  

 Grow Width the width of the components to that value. 

to Largest 

Determines the minimum height of all selected components, then sets  

 Shrink Height the height of the components to that value. 

to Smallest 

Determines the maximum height of all selected components, then sets  

 Grow Height the height of the components to that value. 

to Largest 

Draw Toolbar 
Use the Draw toolbar to set the color and style used by shape, line, and region components. 

 

Align or Space Toolbar 
The Align or Space toolbar is useful when components need to be positioned uniformly. For example, 

you can use it to align several components so that the tops are all even, or you can space components 

so that they have an equal amount of space between them. The first component selected determines 

the position to which the others align. 

Button Function 

Button Function 

  Fill Color 
Sets the color for a shape or region. 

  Line Color 
Sets the color of the border for shapes and regions. Sets the color for a  

line. 

  Line  

Thickness 

Determines the thickness of a line. Applies to line components only. 

  Line Style 
Sets the style of a line. 
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Standard Component Palette 
The icons on the Standard Component Palette represent components that are frequently used to build 

reports. To create a component, click an icon and then click in a band. 

Button Function 

  Align Left 
Aligns a group of components with the leftmost position of the component  
selected first. 

  Align  

Middle 

Centers a group of components based on the horizontal center of the  
component selected first. 

  Align  

Right Edges 

Aligns a group of components with the rightmost position of the component  
selected first. 

  Align Top 
Aligns a group of components with the topmost position of the component  

selected first. 

  Align  

Center 

Aligns a group of components based on the vertical center of the  
component selected first. 

  Align  

Bottom 

Aligns a group of components with the bottommost position of the  
component selected first. 

  Space  

Horizontally 

Spaces a set of components based on the leftmost position of the  

component selected first and the rightmost position of the component  
selected last. 

  Space  

Vertically 

Spaces a set of components based on the topmost position of the  
component selected first and the bottommost position of the component  
selected last. 

  Center  

Horizontally  

in Band 

Centers a component horizontally within a band. 

  Center  

Vertically in  

Band 

Centers a component vertically within a band. 
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Button Function 

  Sele 

ct  

Object 

Selects one or more components within the layout. Also clears any selection (by  
clicking in the white space of a band). 
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Data Component Palette 
This palette offers several components that are identical to ones in the standard palette, except for one 

thing: they are data-aware. 

Data-aware components have the ability to read the value of a field from a database table, and then 

display that value in the report. This is different from the standard components, which display the content 

assigned when you lay out a report. You associate a data-aware component with a given database table 

and field by selecting the data pipeline and the data field from the drop-down lists in the edit toolbar. 

 

Advanced Component Palette 
The Advanced Component Palette contains components that can help you tackle complex reporting 

requirements. 

Button Function 

  DBT 

ext 

Displays data from most types of database fields. Cannot handle images or rich  
text. 

  DB 

Memo 

Prints plain text from a memo field of a database table. It automatically word-wraps  
the text. 

  DBR 

ichText 

Prints formatted text from a memo field. It automatically word-wraps the text. 

  DBC 

alc 

Performs simple database calculations (Sum, Min, Max, Average, Count). 

  RDD 

BImage 

Prints graphics (Bitmaps, GIFs, JPEGs) that are stored in a database field. For  
example, individual and family photos. 

  DBB 

arCode 

Converts the data from a database field to a barcode symbol. 

  DBC 

heckBox 

Displays a Check Box component for the selected database field. Right-click and  

select   to define the style and Boolean values for the check box. Settings 
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Allows you to generate a set of calculations that summarize the data from a  

 Cro database table. It displays the calculations in a grid format. 

ssTab 

Report Tree 
Use the Report Tree to view the components within each band. Components you select in the Report 

Tree become the selection in the report layout. You can select multiple components by holding down the 

Ctrl key and clicking on each name. You can rename components by right-clicking over the name, 

selecting Re name, and then typing in a new name. Make sure to press the Enter key after renaming to 

ensure that the new name is assigned. 

This tool window is dockable only on the left and right sides of the design workspace. 

Data Tree 
Use the Data Tree to create data-aware components within a band. Simply select a set of fields and 

drag the selection into the band. A set of corresponding data-aware components is created. This tool 

window is dockable only on the left and right sides of the design workspace. 

 

Button Function 

  Reg 

ion 

Logically groups components together. 

  Sub 

Report 

Handles multiple master details, creates side-by-side reporting effects, and hooks  
reports together as one. 

Area Function 

Data  

List 

Shows all of the data pipelines in the data workspace. Data pipelines represent a  

database table or SQL query and provide a set of data structured as records and  

fields. 

Field 

List 

Shows the fields for the currently selected data pipeline. 

Data  

Tab 

Shows what data is available for the report. 

Layo 

ut  

Tab 

Allows you to control the format of the components created when you drag fields from  

the Data Tree into the layout. 
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Standard Toolbar 
Use the Standard toolbar to perform basic functions such as opening, saving, and printing reports, as 

well as cutting and pasting selections. 

 

 

Format Toolbar 
Use the Format toolbar to set the font and colors of text-based components. You can also control the 

layering of components with this toolbar. 

Button Function 

  New 
Creates a blank report. 

  Open 
Displays the Open dialog used to open an existing report. 

  Save 
Saves a report to file. 

  Page  

Setup 

Displays the Page Setup dialog used to set the paper size and configure the  

layout for the report. 

  Print 
Displays the Print dialog before sending the report to the printer. 

  Print  

Preview 

Displays the Print Preview window. 

  Cut 
Places the currently selected components in the clipboard and removes them  
from the report layout. 

  Copy 
Copies the currently selected components into the clipboard. 

  Paste 
Pastes the components in the clipboard into the report layout. 



 

 44 

 

 

Edit Toolbar 
The Edit toolbar changes based on the selected component. You can use it with the following 

components: 

data-aware components 
labels 

shapes 

lines 

Button Function 

  

Font 

Shows the name of the font chosen for the selected component. 

  Font Size 
Shows the size of the font chosen for the selected component. 

  Bold 
Sets text to bold. 

  Italic 
Sets text to italic. 

  Underline 
Underlines text. 

  Left Justify 
Left justifies text. 

  Center 
Centers text. 

  Right Justify 
Right justifies text. 

  Font Color 
Sets the text color. 

  Highlight  

Color 

Sets the background color. 

  Bring to Front 
Brings a component to the front of other components. 

  Send to Back 
Sends a component to the back of the other components. Use the  

Report Tree to see the exact layering of the components within the  
band. 
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Report Quick Design Tools 
The Report Designer offers tools to assist you with some of the more difficult report-building processes. 

These tools are: 

• Query Wizard 

• Query Designer 

• Report Wizard 

• Label Templates 

• ACS Report Templates 

• CrossTab Wizard 

Query Wizard 
The Query Wizard is a tool that you can use to access information from your database to use in a 

report. The Query Wizard is accessed from the Data workspace by selecting File | New, and then 

double-clicking Query Wizard. Follow the instructions given on each window of the Query Wizard to 

select data. 

The Data workspace can be used to select and manipulate data for a given report. In most cases, you 

will not need to use the Data workspace when you work in the Report Designer because the Report 

Designer interfaces with ACS Advanced Export to select data for your report. You can use an existing 

Advanced Export or create a new one, depending on your reporting needs. This method of data 

selection simplifies the query process and makes it easier to select data without an in-depth knowledge 

of databases. Using ACS Advanced Export to select data eliminates the need to use the query 

functionality of the Data workspace when you are designing your report. 

Query Designer 
The Query Designer is used to modify query-based dataviews. The Query Designer presents a series 

of notebook tabs; each tab represents a different part of the query. You can use the Query Designer to 

add or remove search criteria from your query.  

The Data workspace can be used to select and manipulate data for a given report. In most cases, you 

will not need to use the Data workspace when you work in the Report Designer because the Report 

Designer interfaces with ACS Advanced Export to select data for your report. You can use an existing 

Advanced Export or create a new one, depending on your reporting needs. This method of data 

selection simplifies the query process and makes it easier to select data without an in-depth knowledge 

of databases. Using ACS Advanced Export to select data eliminates the need to use the query 

functionality of the Data workspace when you are designing your report. 

Report Wizard 
The Report Wizard is accessed from the File | New menu of the Design workspace. A series of 

windows is presented, each requesting information about the report. When the last page is reached, you 

can select either a preview or design option. When you click Finish, the report is created and displayed 

as requested. 
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Label Templates 
The Label Templates wizard is accessed from the File | New menu of the Design workspace. The 

Label Template window displays requesting information about the labels you want to print. You can 

select the type of labels to print on the Products section of this window. Select the appropriate printer 

and product information and click OK to work with a label template. 

ACS Report Templates 
ACS has provided a report template that you can use when you are designing a new report. The 

template includes a Header band with the date, time, church name, and page number. When you select 

the ACS Report Template, the Design workspace is accessed with the template in place. 

CrossTab Wizard 
The CrossTab Wizard is accessed from the File | New menu of the Design workspace. A series of 

windows is presented, each requesting information about the report data and the crosstab layout you 

want to use. When the last page is reached, either a preview or design option can be selected. When you 

click Finish, a report is created and displayed as requested. 

 

Suppressing a Blank Line in Report Designer 
On some reports, you may want to keep lines from printing when there is no data in a field. For example, 

if you print a report that includes the names and addresses for mailing labels, you may not want a blank 

line to print for each address that does not include an Address Line 2. You can suppress the printing of 

a blank line using DBMemo components and the ShiftRelativeTo... option. 

The following procedures walk you through creating a sample report and suppressing Address Line 2 

when the field is blank. 

1. Under Searches and Reports, click the Reports tab. 

2. In the drop-down list, select Report Designer and click Go . 
3. In the Report Type list, select the People report type, then select Create a New Report. 
4. In the lower sidebar, click Customize. 
5. Click Get Report Data > Create a Data Export. 
6. In the Select Export Type window, select Database Export and then click OK. The ACS Data 

Export Designer window displays. 
7. On the Groups tab, select People. 
8. Click on the Included Data tab, select Personal, then click Save & Close. 
9. In the Refresh Export window, enter the number of records you want to limit the export to and 

then click OK. 
10. On the Report Options tab, click Design Report. 
11. In the New Items window, click Cancel. 

Now you can select the name and address fields for the sample report. 
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1. In the design workspace, resize the Detail band to one inch high. 

2. Click DBText . 
3. Click in the Detail band to place a DBText component in the report. 
4. In the Data Field list, select IndividualLabelName. 

5. Click DBMemo . 
6. Click in the Detail band to place a DBMemo component in the report. 
7. Size the DBMemo component to the same height as the DBText component. 
8. In the Data Field list, select Address1. 
9. Place another DBMemo component in the report. In the Data Field list, select Address2. 
10. Place a third DBMemo component in the report. In the Data Field list, select 

CityStateZipFormatted. 
11. Place these fields one below the other, spaced evenly, and align them at the left edge. 

The Detail band of your report should look similar to this: 

 

If your Address2 field contains the text DBMemo2, the first record in your export file does not have 

data in the Address Line 2 field. 

Click the Preview tab to preview the report. Addresses that do not have data in Address Line 2 

display a blank line where that data would be. The report should look similar to this: 

 

Now you can suppress the blank lines in the addresses 
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1. In the design workspace, right-click the DBMemo3 component, which contains the 

CityStateZIPFormatted field. 
2. Select ShiftRelativeTo.... 
3. In the Set object position based on list, select DBMemo2 
4. Click OK. 
5. Right-click the DBMemo2 component, which contains the Address2 field. 
6. Select ShiftRelativeTo.... 
7. In the Set object position based on list, select DBMemo1 
8. Click OK. 

Click the Preview tab to preview the report. The blank line is now removed in addresses that do not 

have data in Address Line 2. The report should look similar to this: 

 
 

Saving Designed Reports 
When you create a new report using Report Designer, you can save it to use again. 

To avoid a long list of reports that are difficult to distinguish from one another, you can organize reports 

into their types.  

Before you create a new report, in the upper sidebar of the reports window, select the type of report you 

are creating. For example, Attendance or Contributions. Then, select Create a New Report and click 

Customize. This ensures that the new report is listed under the report type you selected.  

For example, you want to create a custom Balance Sheet of your assets and liabilities. This is an 

example of a General Ledger report. To save this report under the proper type, double-click General 

Ledger before selecting Create a New Report. When you save the report, it is located under General 

Ledger in the reports window. 

Useful Information 

Suppressing blank lines only works when you have components placed vertically. You cannot  
remove blank horizontal spaces by suppressing components with no data. 
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1. Once you have designed the report, close the ACS Report Designer window. 
2. In the People Suite Reports window, click Preview. 
3. In the preview window, on the reports toolbar, click Save. 
4. Enter a new name for the report. 
5. To make the report available to other ACS users, select Public. 
6. Click Save. 

 

Saving Report Designer Templates 
If you create a report layout that you want to use for other reports, you can save it as a report template. 

For example, if you have several reports you want to use a similar Header for, you can save the header 

and open it through ACS Templates. 

1. Create the report layout in the ACS Report Designer. 
2. Click File, then click Save As Report Template. 
3. In the Save As Report Template window, enter the Template Name. 
4. Select a Category for the template. To add a new category, enter the new category name in this 

field. 
5. Click Save. 

1. Access the ACS Report Designer. 
2. Click the Design tab. 
3. Click File, then New. 
4. In the New Items dialog box, select ACS Report Templates. 
5. Click the tab that corresponds with the category the template is saved in. 
6. Select the template and then click OK. 
 

Importing and Exporting Designed Reports 
Report Designer lets you import reports created by another user. When you import the report, all 

settings, including the associated data export settings, also import. Once the file is imported, you can 

open it in Report Designer for use or modification. 

2.  In the drop-down list, select Report Designer and click Go.  
3. In the upper sidebar, select Create a New Report. 
4. In the lower sidebar, click Customize. 
5. On the Report Options tab, under Design the Report, click Import Report. 
6. Navigate to the report and click Open. 

1 .   Under  , click the   tab. Searches and Reports Reports 

Note 

You can only import reports that have been successfully exported from Report Designer.  

If you try to import a report file that hasn't been exported, a message displays indicating that the  
report file (.rtm) does not contain a valid version number. 
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7. A message displays indicating the last time the exported data was refreshed and gives an option to 

limit the number of records exported. Do one of the following: 
To export all data and refresh it, click Yes. 
To limit the number of records exported, enter the maximum number of records to export and click Yes. 
To refresh the data or limit the number of records exported, click No. 

1. Under Searches and Reports, click the Reports tab. 

2. In the drop-down list, select Report Designer and click Go.  
3. In the upper sidebar, select the report. 
4. In the lower sidebar, click Customize. 
5. On the Report Options tab, under Design the Report, click Export Report. 
6. Navigate to the location where you want to save the report. 
7. Click Save. 

The report is exported to the selected location. 

 

Updating and Deleting Saved Reports 
In Report Maintenance, you can delete, transfer or make a user's saved reports public.  

For example, an employee may leave suddenly and no one may have his password. If you'll continue 
using these reports, you can transfer them to another user. If you won't use these reports, you can delete 
them to clean up the list. 

1. In the reports window, click Maintenance. 
2. In the User drop-down list, select the ACS user whose reports you want to delete, make public, or 

transfer. 
3. Select the action (Delete, Make Public, or Transfer to). If you select Transfer to, select the ACS 

user who gains access to the reports. If you remove or transfer reports, you must remove or 

transfer all of the ACS user's reports- you cannot select which ones to remove or transfer. 
4. Click OK. 

Customizing the Reports Window 
In ACS, you can create customized views of the reports window. Creating customized views lets you 

decide what reports display. This is helpful because you only see the reports you want to, rather than a 

complete list of every report associated with a module. You can select to display reports from any ACS 

module your organization uses. You can also delete a report view if you no longer need it. 

For example, you might set up a report view called Monday Morning Reports. In this view, you would 

include all of the reports that you regular run on Monday mornings, such as the Roster Attendance 

Summary and Breakdown Analysis on Gifts - Weekly. When you select the Monday Morning Reports 

view, only these two reports display. 

http://10.22.99.19/display/ACSDOC/The+Reports+Window


 

 51 

 

1. In the upper sidebar of the reports window, click the Down Arrow  beside the module you are 

currently viewing. 
2. Click Define Views, then click New. 
3. Enter a Name for the customized view. 
4. To select the reports you want to include, select Selected Reports and click Select. The Select 

Reports window displays. 

5. Select a report you want to include and click Add.  
6. Repeat these steps for each report you want to include in the view, then click OK. 
7. To display the customized view now, click Apply View. 

You can select this customized view at any time by clicking the Down Arrow  beside the report 

area you are currently viewing. 

1. In the upper sidebar of the reports window, click the Down Arrow  beside the module you are 

currently viewing. 
2. Click Define Views. 
3. Select the report view you want to delete, then click Delete. 
4. When the confirmation message displays, click Yes. 

In ACS Financial Suite, you can print all reports in a report view. 

1. Under Generate Reports, select the Reports tab. 

2. Select a module name, then click Go . 

https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
https://wiki.acstechnologies.com/display/ACSDOC/Financial+Suite
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3. In the upper sidebar of the Reports window, select the report view you want to print reports for in the 

drop-down list. The reports in the view display. 
4. In the lower sidebar, beside Batch Processing, click Preview All to display all reports, or Print All 

to print the reports. 


